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Introduction

createspace

CreateSpace is a self-publishing service which allows artists to publish and sell their books, CDs,
and DVDs for a fraction of the cost of traditional methods. Many years ago this companywas
bought out by Amazon and now it is Amazon’s print-on-demand (POD) publishing arm. So, by
using CreateSpace, a self-published author is directly tied to Amazon. This means youare
under the protection of Amazon and you have direct access to a great sales market.
Amazon.com and CreateSpace.com are both designed in ways which make it easy for usersto
publish, protect, and market their work.

e
—T— [
a\ y‘[ﬁ https:// v createspace.com/ O - @ B ¢ X | @ CreateSpace: Self Publishin... % D Y I
x  ®)Trend Micra Taalk File Edit View Favorites Tools Help
createspace
\ Books | Music | Film | Free Publishing Resources | Member Spotlight | My Account Community Help W Cart

an Amazon company LogIn Sign Up

Access your Account

s Publish your words, your way.

Tools and services that help you complete your book and
Password make it available to millions of potential readers.
For 5

Ready to go?
m Start your free online setup now. Get in touch with our publishing experts.

Learn more

What's new?

AMAZON EUROPE

Make your book available ‘
E for free! L ) T 2
g!na:rlzwre‘oar ree Authors Musicians Filmmakers New! Distribute your book with Amazon Europe.
MAKE YOUR BOOK DIGITAL
Creating a Kindle eBook
has never been easier. e -
ey Independent Publishing with CreateSpace
P Free and Easy Tools S5 ?\ Higher Royalties
Do-it-yourself and finish fast with tools like (" $ ) Place more in your pocket with some of the
| Co review, and 28 L e n the industry.

e
9:34 AM

-~ ® G
o 10/2/2012



CreateSpace Publishing

Before Kindle and other eReaders entered into our lives, paperback books ruled the book
market. There is still a large demand for paperback books, and many people still loveand
embrace paperbacks in spite of the large influx of the electric devices available forreaders
these days. You don’t have to use CreateSpace to take advantage of print-on-demand
publishing; however, it can be very advantageous for the self-publisher since it is alreadylinked
to the Amazon marketplace.

Print-on-demand publishing is exactly what it sounds like. In print-on-demand publishing, your
book remains digital until someone purchases it. In other words, the book is only printed on an
individual basis, per order, and upon demand.
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Before print-on-demand publishing, you pretty much had three choices: You could printyour
books on your own, you could get go through a vanity press and make expensive orders of
1,000 books or more, or you could seek out a publisher if you felt that your work was good
enough to bring about profits. Even if you could get published through a publishing agency, you
would likely only get royalties of 10% or less. Now you can self-publish and bring about a
substantial stream of income for yourself. With CreateSpace, you will see that the royalties for
you book could be as high as 30 or 40%; that is after printing, shipping, and all of the other
services that the company provides for you.

If you are dissatisfied with a CreateSpace service or if your CreateSpace
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g g & product contains a manufacturing defect, contact us within 60 days and
we will do everything we can to make things right or refund your

money.



Again, there are other companies which provide this type of service. CreateSpace is notyour
only option. However, Amazon is the platform of choice for many buyers and sellers. In fact, it
is the largest book retailer in the world. So, it really doesn’t make any sense toventure
elsewhere, especially if you are already using Amazon to publish eBooks through Kindle.



Why Publish to CreateSpace?

zo0's Print-On-Demand (POD) service for paperback books

e o, Ama
CreateSpacs Here's what it used to ba like to publish a physical book +

How to Publish a Paperback
Book to Amazon for Free
Using CreateSpace

Why Publish with
CreateSpace? Back of the room" sales

Point and Click” publishing +

Using CreateSpace is an incredibly cost-effective way to publish your work. In fact, itis
completely free to publish your book to CreateSpace. The only thing that you will be paying for
is for Amazon to fulfill your book orders. Even this is incredibly cheap. For example, ordering a
proof copy and shipping it only costs about $7. These types of services will cost money, but
everything else is free.

In CreateSpace, shipping and printing costs typically take up about 60-70% of the total book

price. This may vary by the amount of images, colors, and pages that your book contains. Even
so, this leaves you with 30-40% in profits. For instance, a book which has a selling price of
$15.95 that is 100-120 pages (with no images) will typically bring about royalties of about S5
per sale.

This is harder to achieve with an eBook. Publishing paperback books are likely to bring inbigger
royalties because the selling price of these books is higher. A Kindle book typically starts outat
a selling price of $2.99. You may be able to bump the price up a little bit if you are selling a
“How To” book or a book of a longer length, but not very much. In order to bring about aprofit
of S5 per sale with a Kindle eBook, you would have to price it at a minimum of S7, even ifyour
royalties are 70%. People expect paperback books to be more highly price. On the otherhand,
when you publish a Kindle eBook, the prices are expected to be much lower. Therefore, the
royalty rates in a paperback book can be worth the extracost.



You can also purchase your own book. For instance, if you would like to publish a book touse
as a marketing tool to promote your business, you can order as many copies fromCreateSpace
as you would like. Jay Boyer, for example, used to do web services for other people. He
created a book about his services and published it, ordering a couple of dozen at a time. He
would then hand them out to his potentialclientele.

Many professionals do this. In professional business practices, such as realty, construction, or
chiropractics, these publications bring about an air of professionalism that is unmatched. This
can bring in a substantial amount of profits and the published works pay for themselves ina
short amount of time. If you do any kind of public speaking at all, you can make a greatamount
of excess cash by selling your book at the back of the room. All of these options (and much
more) are available to you if you learn to publish with CreateSpace.

Overview  Cover Interior  Printing Options Distribution and Royalti Buying Copies
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Support

Competitive Royalties

Affordable Copies

No Setup Fees

Library-Quality Books

Free ISBN

Standard Distribution

Expanded Distribution

Learning to use CreateSpace effectively is not a difficult task. Using CreateSpace isextremely
easy, that is why it has been deemed “point and click publishing”. If you have nevertried
anything like this before, it typically only takes about an hour to learn. If you have ever
published for Kindle, you will notice that CreateSpace is organized in a very similar, easy touse,
fashion as Amazon.

CreateSpace has a cover-creation tool that is very simple to use. It is not the mostamazing
graphics utility available, but it is free and you can use it as much as you like. With this tool you
can make a professional-looking cover in just a few minutes. Another advantage of
CreateSpace is that changing your prices and testing new ones is also extremelysimple.
Furthermore, any changes to your pricing that you make will take place within a couple of
hours.



The point of publishing in Kindle and CreateSpace is to create multiple streams of passive
income through on-demand publishing. The tools described here are going to allow you todo

so in a simple, hassle-free way. They are also going to position you in one of the largest
markets for books and eBooks available.



CreateSpace is Seamlessly Integrated with Amazon

CreateSpace is advantageous because it integrates seamlessly with Amazon. This is a big
benefit that CreateSpace has over other self-publishing companies like LuLu.com orXlibris.com.
This also means that there are not any additional steps to take when you finish your book. Your

book will “go live” as soon as you sign off on the proof copy, and your sales canbegin.
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Once the book has been created and placed onto the marketplace, Amazon takes care of
everything for you. When you publish an eBook, selling the publication is incredibly simple
since it is all in a digital format. With printed physical books, the process is muchmore
complicated and costly. There are hard costs involved such as:

* Printing

* Shipping

* Payment Processing
* Customer Support

* Returns

* Package Tracking



The costs of publishing and distributing physical books bring up the overall price of the books.
Consumers understand this; that is why they do not mind paying $12.99 or more for asingle
book. Amazon takes care of many of these problems and expenses for you, however. Issues
with any of the aspects listed above, such as customer support, are taken care of byAmazon.
This makes a process which is normally very frustrating and expensive, incredibly easyand
inexpensive for you.

One of the best aspects of being so interconnected with Amazon is that they are sowell-known
and well-liked. There are currently over 3 million unique visitors to Amazon every day. Many
businesses pay millions of dollars every year for this amount of exposure. This is trafficthat
they are funneling to you for free. People also love and trust Amazon shipping. Many people,
for example, who cannot drive or get around well, are Amazon Prime members because their
shipping is free.



Why People Disregard the POD Platform

Many people do not publish with print on demand for a variety of reasons. Some ofthese
reasons are:

* The eBook market is successful

* Theydon’t know how

* They are focused solely on kindle

* They feel it would be too complicated

This is understandable, especially if you are making good money in the Kindle marketplace. You
should understand, however, that if you have an eBook published and you are not utilizing
POD, then you are essentially leaving money on the table. There are a lot of people who will
never purchase an eBook because they don’t understand the technology or they don’tfeel
comfortable purchasing virtual items. There are also a lot of people out there who are afraid of
change or believe in the old-fashioned way of doing things. There is nothing wrong withthese
beliefs and there is no reason why you shouldn’t appeal to this type of audience aswell.
Everything that you are publishing in Kindle you should have available in POD as well. There isa
little more work involved, but nothing so intense that it should stop you from trying it out.
Many people feel like they do not have enough time to do both, but really time shouldn’t be an
issue. You have to make some changes to the formatting and the book cover, but typically this
takes less than an hour. So, with just a minimal amount of effort you will be able to “double-
dip” into both markets.

There are some types of books that even sell better in print. For example, Jay published adog
walking book in both CreateSpace and in Kindle. In January, he sold this book on kindle for
$6.95 apiece and brought in a profit of $48.50. The same book, with the same content, in the
same month sold in the POD format, bringing Jay a profit of 101.41. That is almost twiceas
much in royalties. It does not always happen this way, but you can see that you could be
missing out on a significant amount of profit by not publishing in Kindle and through
CreateSpace.

Even if you take the risk and you do not sell well in the POD market, it is likely that you willat
least earn back any money that you invest in the venture very quickly. After the initial costs
whatever you sell is pure profit. Another great aspect of CreateSpace is that it offersan
expanded distribution option for a very low price. If you do this, CreateSpace will make your
book(s) available to libraries, book stores, and other book retailers. The good thing about this is



that these buyers order in bulk. So, when you get your royalty check from these sales, it is
typically a lot larger than what you are used to.



Formatting Your Book
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communicate to the public that you have a good
product, that you offer a good consumer experi-
ence and that they should buy stuff from you,
rather than one of your competitors.

You will, of course, have to format your manuscript into book formation when publishinga
paperback. If you don’t already have your manuscript saved in a Word Document, you will
want to copy and paste the text into Word and save it. If you already have the text in aWord
document formatted for Kindle, you may wish to save it under a different name before making
the changes needed for CreateSpace. Some people use a pre-formatted template fortheir
CreateSpace document which includes the followingspecifications:

* Page Size: Book Trim (6”x9” is the most common)
* Margins: .75”
* Gutter: .35”

The outside edges of the margins should be wider than the inside edges, this is because % to %
of an inch will be lost in the book’s binding. This will need to be accounted for inyour
formatting. You can do this by clicking on the “Page Layout” tab in Microsoft Word, andthen
clicking on “Margins”. When the “Page Setup” window opens, modify the settings asfollows:

Margins
Top: 0.7”
Inside: 0.7”

Gutter: 0.35”
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The top and side margins, set at 0.7” will make them nearly3/4 of an inch. You may also wishto
set them at 0.75, to make the margins an exact % of an inch. The gutter is set at 0.35”. The
margin is already set to 0.7” and the gutter adds an additional 0.35” to the outside margins.
This is what makes the outside margins wider in preparation for the book’s binding.

The page size of your document will also have to be customized. To do this, click on the “Page

Layout” tab again, and then click on “Size”. Next, click on “More Paper Sizes” and changethe
settings in the window as follows:

Paper size:
Custom size

Width: 6”



Height: 9”
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This may vary according to your desired trim sized.

This process is very similar to that of formatting a Kindle book. One of the biggest differences
to note is that not everyone who publishes in Kindle puts hard page breaks in between the
different section of the book. When formatting your printed book, you should insertthese
page breaks between the chapters. All you have to do to insert the page breaks isposition
your curser on the front of the line of text where you would like your next page to begin. After
that simply click on the “Insert” tab and then click on “Page Break”.

For the chapter headings you will be using Heading 1 (H1) tags to format your book, just like
you would be when formatting a Kindle eBook. If you have subtitles, you want to use H2tags
for them. Continue to do this throughout yourmanuscript.
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chapter title 1 Norma No Spacing  Head E;L Heading 2 Heading 3 Heading 4 feading 5
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Heading & Tite Subtitle Change



Get everything formatted just the way that you like and make sure that your chapter headings
are set up correctly. Be sure to include a title page, copyright page, and a table of contents
page at the beginning of your manuscript. You may also need to include a disclaimer page.

Serif fonts are the most widely used in printed materials. These are the fonts that have semi-
structural details on the ends of the letters. Times New Roman and Georgia are goodexamples
of serif fonts. These are the fonts that you should use when submitting your manuscript.

After your manuscript is thoroughly edited and formatted, go to your table of contents. Next,
click on the “References” tab and then “Table of Contents”. Choose the style that you wish to
have for your table of contents, and it will auto-generate the correct page numbers foryour
chapter headings.




J 3 Manage sources j e Insert Table of Fiqures. D 2 msert index B 3 Insert Table of Authorities
@ syle aPaFftt. € ¥ Update ndex A Uodate
Mk Mark
- i Bibliography - c.,,,. ﬁ Cross-reference o Chation
blograghy Caprons index Table of Autnorkies
e

CONTENTS

Heading 1 i
T adin i :
Automatic Table 2

TABLE OF CONTENTS

TABLE OF CONTENTS
Heading 1 i

Wndiann
Manual Table

TABLE OF CONTENTS
‘Type chapter title (Tevel 1) ... 1

Tia AR AR AL Ee S =
[ More Tasle of Contents frem Office com |
2 Insert Taole of Contents..
B | emore fabske of Cottents

You will want to wait until you have finished formatting before creating your table of contents,
but if you have to make changes later, you can fix the table easily. All you have to do is left click
on your table of contents, click “update field”, and then choose “update page numbers only”.
You don’t want to choose update entire table, especially if you have already formatted your
document.
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How to Create a Book Cover

One of the major changes you will have to make when changing your book from a Kindle eBook
to a paperback is your book’s cover. For a Kindle cover all you have to have is a cover design for
the “front” of your book. In a paperback format, your book will (of course) need a front, a back,
and a spine because this is a 3-dimentional object.
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This is actually advantageous to you, because the back cover text usually tells the reader more
about the book and its author. This is essentially a sales page for you. You can even adda
picture of yourself or listing of your other works.

You have 3 options to create your paperback book cover:

1. Use the CreateSpace Cover Creator Tool (see the “CreateSpace Submission Guide” pdf
training, and watch the accompanying videos).

2. If you have the skills needed to design the cover yourself with PhotoShop or Paint, you
can do it yourself.

3. You can also outsource this cover design to a professional designer

I almost always outsource my cover designs, and | do it cheaply by finding contractors at sites
like Fiverr.com and Odesk.com



You can get a lot of great graphic work done on Fiverr.com for a low price. You will, of course,
have to pay more than the standard S5 dollar fee for this professional of work, but it is still a lot
cheaper than hiring a graphic designer elsewhere. One of the problems with this website is
that it is hard to find a very professional graphic designer on Fiverr.com. The website isreally
better at providing simple imaging. Another problem with this website, for this type ofa
project, is that if you find a good graphic designer then it is hard to find them later onsince
people don’t typically keep working very long on the website.

There are some very good workers to be found out for this type of project on oDesk.com. If
you get a cover designed for your Kindle eBook, it is a very good idea to use the samedesigner

for your paperback book cover. That way your covers are consistent. It is also best tohave
both designed at the same time.



Your Book Cover Template

Your designer will need a template to use in the creation of your book cover. You can find one onthe
CreateSpace website, CreateSpace.com on a page titled Book Help > Artwork & Templates. To gohere
follow this link:

https://www.createspace.com/Help/Book/Artwork.do;jsessionid=67E§20AEDE11153090ACAE2D883428

B50.7b2b93363fe5fb26d25b5e54fbd1a330
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Book Help >

we have developed templates to make it easier for you to quickly create print-ready files in graphic design software programs such as Adobe
Photoshop®, Adobe InDesign®, or any software that will allow you to open a png or PDF file and save a PDF file.

Product templates are downloadable files that provide information on dimensions, layout and bleed. You can find additional helpful information in
nents,

our Submissi
We recommend that vou format your cover with our templates, but understand that you may already have existing artwork for your book. If this is
the case, please follow our Instructions for Using an Existing Fidly Farmatted Cover to ensure your existing artwork will work with our system.

Using our templates is smple. Configure and downioad the template that meets your book's spedfications, then follow the mstructions below to
create your artwork.

Configure your Template How to use your Template
Iieoriis Black ana White - 1. Open the PDF or PNG file for the Paperback Book Cover Temlate in vour
- image editing software. I

Trim Size 5'x0" . 2. Create a new layer in your image editing software. This layer will serve

35 the design layer.
embevotERgeasg) 120 RO 3. Design your cover in the design layer, using the template PDF or PNG fila

a5 the quide layer. The a should extend to the outside adge of
Paper Color Whie v the temlate's pink zone ure a white bore not exist within

the printed work. Do not move the guide laer, as it is properly aligned

for our printing specifications.

4. Ensure text and/or images that are intended to be read do not appear
in the pink zones of the template.
Build Template
5. The barcode area is indicated in yellow on the tempiate. Do not place
important images or text ing to be read in the barcode location
We suggest filing in this ith your background color or desin.

Once your design is comolete, you will need to turn off the guide layer
S0 that it s not printed on your final product or rejected during the
review process. If you are unable to tum off the guide layer, then you
will need to format the artwork so that it completely covers the guide
layer.

7. Flatten all layers, save the file 35 a press quality PDF, and upload the file
through your CreateSpace account.

What you’re going to receive here is a PSD file in the book trim size of your choosing. It will be inthe
form of a zip file that you can send to your designer. He will load this into PhotoShop and it willinclude

Configure your Template

Interior Type Black and White |
Tnm Size 68" %9 - |
Number of Pages 125 pages

Paper Color White = I

Build Template

the spine width, the blank for the UPC code in the back, etc.



Begin by configuring your template in black and white. Your book trim size should probably be 6”x9”,
since it is the most popular size. You will need to include the number of pages as well so thatthe
program can calculate the thickness of the spine for your book. CreateSpace will want you to makeyour
book an even number of pages. You can add an extra blank page if you need to. Also, you should
understand that your book must be at least 100 pages long for CreateSpace to be able to print yourtitle
along the spine; otherwise it won’t be thick enough. So, if you are close to a 100 page manuscript, you
may choose to make it a little longer so that you can have the title printed there. Note: 24 pages isthe
minimum amount of pages required by CreateSpace.

The template generator will also give you the option of choosing white or cream for your papercolor.
This is important because if you choose cream the paper will be thicker, and therefore you book’s spine
will need to be larger. The template generator will calculate the difference for you, however.

CreateSpace
Paperback Book
Cover Template

6.0” X 9.0” Book

124.0 Page

0.28” Spine Width

» P i White Paper

nnnnn

After you make your selections, simply click on ‘Build Template’. You will be sent to a page where it will
show you that the zip file will include a PNG Template and a PDF Template. Here you can click a linkto
download the template. While you are on this page you will want to click on the link which says
“Instructions for Using an Existing Fully Formatted Cover”.

The next step is to send all of this information to your book cover designer. Include the png template
file that you have just downloaded from CreateSpace above, as well as very detailed instructions toyour
designer on your book’s topic, title, text, color, images, etc. Here is a sample set of designerinstructions
that you can modify for your own book cover:

This book contains general "how to" advice targeted to small businesses to help themimprove
their bottom line via yellow page ads, referrals, upsells, branding, etc.

The author is an online consultant who will be using this book as a promotional tool tobrand
himself as an "expert".

| am attaching a 6" x 9" book cover template for Photoshop with instructionsinside.
Please let me know if you have any questions.

Title = Small Business Marketing Strategies



Subtitle = Increase Your Profits by 20% in 100 Days
Author = Mike Koenigs

Image = attached

Template = 6 x 9 attached

Total Pages =92

Back cover text =

Do you know the most profitable skill for running a small business? It's not keeping the shelves
stocked. It's not managing employees. It's not even about having the best product orservice.

No, the most essential skill that you must master is the ability to market your business. Why?
Well, the only way that your business can grow is if you actually SELLsomething.

Poor marketing is why 65% of new businesses close their doors within 24 months, and why85%
of businesses don't last 8 years before going under.

Let me show you the 7 most powerful (and profitable) marketing strategies that you can use to
transform your business' bottom line in 100 days or less.

2. This book contains "how to" advice for small business owners to show them how to gettheir
business to show up on page 1 of the search engines using Search Engine Optimization, aGoogle
Places listing, etc.

The author is an online consultant who will be using this book as a promotional tool tobrand
himself as an "expert"

| really liked the style of the last book in terms of font, imagery, and layout. | also liked howyou
did the back cover with Mike's picture, etc. | know this image is not as good as the last one of
Mike...hope it is usable. Please go with whatever you think is best for thisone.

And please give me a holler if you have any questions, and deliver both a pdf and psd file ofthis
completed cover.

Title = Page One Secrets

Subtitle = How to Get Google to Love Your Company's Website
Author = Robert "Rocket" Helstrom

Image = attached (please let me know if this is usable)
Template = 6 x 9 (attached)

Total Pages =92

Back cover text =

You can have the slickest website in the world, but it won't matter at all if your customerscan't
find you on Page 1 of Google, Yahoo and Bing.



"Page One Secrets" will lay out for you a step-by-step method that you can use to scorea
coverted Google Places listing for your business for any local search term.

It will also take you "behind the scenes" to show you proven SEO tips and tricks that most
webmasters will never know...and which you can master in minutes.

If you are wondering how to finally get your business "found" online...generatevaluable
leads...and turn them in to customers for life, this book is a must-read.



